Lesson 2: Setting up Your Environment

Lesson Objectives

- Set User Preferences
- Create a Design Template

Setting User Preferences

*OrCAD Capture, Version 16.6,* has the following user preferences:

- Color assignment
- Grid display
- Pan and zoom
- Area selection
- Line and fill style
- Autobackup

User preferences are workstation-specific. For example, if you copy a design from another person and open it on your machine, your user preferences (color assignments, grid display) are used.

User preferences are stored in the *Capture.ini* file (not in the design database). Changes to user preferences take effect immediately.
Color Assignments

Use the *Colors/Print* tab to assign colors to design objects and to control visibility of design objects on hard copy prints.

**Variant Settings (Used in OrCAD Capture CIS only)**

![Variant Color Settings](image)

The *Default for Variant* color setting is only used by OrCAD Capture CIS to display on the schematic page any part(s) that are marked in the Variant BOM section (green) and which parts are marked with a “Do not stuff” property (gray).

**Grid Display**

Use the *Grid Display* tab to turn the grid on or off, or to specify grid style.

OrCAD Capture uses a 100-mil grid. The *Pointer Snap to Grid* option forces all parts, wires and text to snap to this grid. A *Snap to Grid* icon is also available on the main toolbar.

When you are adding parts and wires, the *Pointer Snap to Grid* option should be on (the default). You should turn this option off when adjusting the location of text or properties only.

The *View - Grid* command can also be used to toggle the grid on or off. You can set preferences to display either a dot or line grid system. You can also specify whether you want placed objects to automatically snap to the grid.
It is recommended that you set *Fine* for Drawing Elements such as text, lines, rectangles, etc. This will allow movement of objects at almost a “gridless” setting. Set *Coarse* for Connectivity Elements such as parts and wires to allow these objects to move using the grid spacing setting. The setting for *Master* will let both object types behave in the default manner.

**Pan and Zoom**

When you use the Zoom In or Zoom Out icons in the main toolbar, OrCAD Capture refers to this setup menu to determine how far to zoom in or out. Similarly, the amount of zoom performed by the *View - Zoom* menu options or the `<I>` (Zoom In) and `<O>` (Zoom Out) keyboard shortcuts is also defined here.
The *Auto Scroll Percent* option controls how fast the schematic page scrolls when you drag an object into the border area of the schematic window. It is an old feature has been replaced by the action of selecting the `<C>` key, holding it down, and moving the mouse.

The zoom factor must be an integer between 2 and 10 (no fractions or decimals).

![Preferences dialog box](image)

The new function of the `<C>` key replaces the use of the Scroll settings.

**Area Selection**

To select multiple objects, you can use your left mouse button to drag or draw a rectangle around the objects you want to select. All objects intersected by the rectangle are selected by default. However, if you prefer you can alter the settings in the *Options - Preferences - Select window* to select only objects fully enclosed.
The graphic that follows shows a selection rectangle and objects selected when the *Intersection object* is activated as a preference as well as objects selected when the *Fully-enclosed* option is activated. Both of these settings now have an icon on the main tool bar to allow you to switch between the settings without the need to set them here. (Refer to Lesson 1 and page 2-11 of this lesson.)

**Selection Preferences**

When you drag a rectangle to select multiple objects, all objects intersected by the rectangle are selected by default. As introduced in the previous sub-topic, you can modify preference settings so that only objects fully enclosed within the rectangle are selected.

Use the *Select* tab to set your area selection preference. After selecting multiple objects within an area, you may plan to move them. Use the options on this tab to specify the maximum number of objects that are visible at high resolution while moving the selected group. When you drag a number of objects greater than this value, a simple box replaces the symbol graphic for each part.
The “Maximum Number of Objects to display.” message is an older setting that, with the advent of the high resolution graphics cards, is no longer a setting worth using. Simply leave it set as is.
Use the **Miscellaneous** tab to define the characteristics of non-electrical graphics such as polygons and lines. You can also choose to render text as small line strokes rather than text fonts.

Set the default line draw mode for the schematic page by selecting **Schematic Page Editor - Line Fill** and **Line Style and Width**.

**Junction Dot Size** will let you set the size of the Junction Dot to **Small** (Default), **Medium**, **Large**, and **Extra Large**.

**Docking** will allow you to open and dock the **Place Part** command box and leave it open as you find and place parts on the schematic page.
Find will allow you to open and dock the find command or Search Toolbar.

The Auto Recovery option protects you from loss of work due to system crash or power failure. OrCAD Capture automatically saves design changes at the end of each Auto Recovery interval (in minutes). These backup files are saved to the “current working directory”, and are automatically deleted when you exit normally. If no changes have occurred since the last save, no auto recovery (backup) is performed.

**Preserve Reference on Copy**

Enable part references to be preserved while pasting a part to a schematic page. When you copy a part and paste it on a schematic page, the part will retain the same reference designator as that of the copied part. But, if you place a new part on a schematic page, OrCAD Capture will assign the reference designator found in the library. For example: U?A or J?P.

The Intertool Communication option lets OrCAD Capture interact with the OrCAD and Allegro PCB Editor tools. For example, you can cross-probe parts and nets in the schematic and correspond them to parts and nets in the PCB design.

The Auto Reference option will automatically give you the next reference designator in a sequence. If you wish to use the Annotate command, do not use this function.

The Wire Drag option (ON) allows you to drag and place the selected part or wire on the schematic, even if it results in connectivity changes. Also, OrCAD Capture flags a warning with a changed cursor and will show the temporary markers.

(OFF) then the selected part or wire attaches to the cursor and does not get placed on the schematic, if it results in connectivity changes. Also, OrCAD Capture flags only a warning with a changed cursor and does not show the temporary markers.

The IREF Display Property setting will display the Intersheet Reference text after it is generated.
Text Editor and Board Simulation Tabs

Syntax Highlighting
- Keywords
- Comments
- Quoted Strings
- Identifiers

Current Font Setting
- Font: Courier New
- Size: 10
- Style: Regular
- Effects: None
- Color: None

Tab Setting: 4 spaces
- Highlight Keywords, Comments, and Quoted Strings

Show line numbers
- Save text files on deactivate
- Auto reload text files
- Save text files before running tools

Reset

OK  Cancel  Help
The **Text Editor** Tab is used to set up color, font, and highlighting for Verilog or VHDL keywords, comments, and quoted strings. These settings are applied to a text editor window that is used to create behavioral models.

The **Board Simulation** tab is used to specify which hardware description language will be used for simulation.

The **Tab Setting** option in the Text Editor tab can also be used to align the columns or data in the Bill or Materials report.
Lab 2-1: Setting up Preferences

Lab Objectives

After completing this lab you will be able to:

- Set color assignments
- Set the grid display
- Pan and zoom
- Select an area
- Set selection preferences
- Set miscellaneous preferences

Assigning Colors

If you closed the design in the last lab, reopen intro.dsn.

1. In the Project Manager window of the, double click PAGE1.
2. Enlarge the schematic window and zoom in to capacitors C1 and C2.

   Observe the current color settings. Symbol graphics are blue, wires are purple, reference designators are dark blue, and text is black.

3. Select Options - Preferences
4. The Colors/Print tab is the first to be displayed.
5. Click the color box next to Part Body, click a different color from the color palette, and then click OK.
6. Next change the color assignments for Part Reference, Part Value, and Wire also.
7. Change the Grid color to black so you can see it easily on the screen.
8. Click OK.

The color assignments take effect immediately. These preferences are machine specific (any design opened on your system will use these color settings).

If your grid is not visible, use the View - Grid command to turn it on.

Using Default Colors (Optional)

9. Select Options - Preferences.
10. Click the Use Defaults button in the lower right corner of the Colors/Print tab, and click OK.
11. The schematic displays the original color assignments.
12. Try several more color assignments (for example, Alias, Background, Junction, No Connect, Pin, Power, Power Text, and Title Block).
Assigning colors to some of these objects helps you prepare for the design entry tasks covered in the next lesson.

**Select Tab**

1. Select Options - Preferences again.
2. Click the *Select* tab.
3. Change the Area Select setting for the Schematic Page Editor to *Fully Enclosed* and click *OK*.
4. Return to the Project manager window and open Page2 of the design.
5. Zoom in to U2A (74LS00).
6. Drag a selection rectangle across (but do not fully enclose) U2A.
7. Observe that the part is not selected.
8. Drag a larger selection rectangle and fully enclose U2A (including pin stubs).
9. Observe that the part is now selected.
10. Click left in a blank area to deselect all objects.
11. Select *Options - Preferences* and click the *Select* tab.
12. Change the Area Select setting back to *Intersecting* and click *OK*.
13. Drag a rectangle across a portion of U2A to select it.

One Icon on the OrCAD Capture main tool bar also performs the same task without having to go to the User Preferences.

![Fully-Inclosed](image)

![Intersecting](image)

**Miscellaneous Tab**

1. Select *Options - Preferences*.
2. Click the *Miscellaneous* tab and do the following settings.
   a. For the *Schematic Page Editor* set the *Line Style* to dashed.
   b. Set *Auto Recovery* on and for 15 minutes.
   c. Remove the “check” for *Auto Reference*, for now. This will enable us to us the *Annotate* command later in the labs.
   d. Make sure there is a “check” in the *Wire Drag* option.
3. Make sure all your settings reflect what is displayed in the following image.

![Preferences window](image)

4. Click **OK**.

**Set AutoBackup Preferences**

1. Select *Options - Autobackup*.
2. When the “Multi-level Backup settings” window opens, select the Browse button.
3. Find the D:\EMA_Training\Capture.
4. Using the **Create Dir** button, enter the directory name for **Backup**.
5. In the Select Directory window, make sure you select the Backup directory under D:\EMA_Training\Capture.
6. Select **OK**.
7. Enter the time interval you wish backup to occur and the number of backups you wish to save. Click **OK**.

**Closing the Project**

1. Select **File - Close**.
   
   The schematic window closes.
2. Select **File – Save Project As**.
3. The **Save Project As** dialog will appear. With the Home tab active, enter the directory location.
4. Enter the Project Name and click OK.

The Project Manager window closes. The main session window is still running.

**The Design Template**
The design template is a collection of settings that are used whenever you create a new design. These settings are design specific and are retained even when the design is transferred to another workstation.

When you define settings of your design template, you define the:

- Font type and size
- Title block
- Page size
- Grid settings

Design template settings are stored in the Capture.ini file. When you create a new design, the current settings are copied into the design file. When you change the design template, existing designs are not affected.

You can override text font settings at the design level using the **Options - Design Properties** menu item, or override page size and border settings using the **Options - Schematic Page Properties** command.
Fonts Tab

You can use the **Fonts** tab to control the appearance of various kinds of schematic text (for example, net names, reference designators, properties, and so on).
Title Block Tab

You can use the Title Block tab to specify which title block symbol you want automatically added to each new schematic page. You can also fill in your company name and address.

If you also supply design name and revision information, remember to change these settings before starting a new design.
You can use the **Page Size** tab to set the default page size for new schematic pages. Also use this menu to specify the units of measure and the page dimensions.

OrCAD Capture always maintains one grid space between pins. The default grid spacing is 100 mils. The **Pin-to-Pin Spacing** field changes the distance between grid points (which changes the distance between pins).

Do not change the **Pin-to-Pin Spacing** field (always use a 100-mil spacing or “tenth of an inch”).

For example, a **Pin-to-Pin Spacing** of 200 mils causes the size of parts to increase by a factor of 2 to 1, because the distance between adjacent pins is 200 mils. Thus, the **Pin-to-Pin Spacing** field scales the schematic.
Grid Reference Tab

You can use the *Grid Reference* tab to define the grid zones across the top and left edges of schematic pages. Also use this menu to control visibility of the title block.

Hierarchy Tab

This tab lets you set the default setting for Hierarchical block symbols. We will cover more on Hierarchical designs in a later chapter.
Lab 2-2: Setting Up the Design Template

Lab Objectives

After completing this lab you will be able to:

- Set up default options for your designs
- Add a title into the title block
- Add a name and address to the title
- Add a document number and revision number to the title block

Setting up Default template settings

1. Select Options - Design Template.
2. Select the Page Size tab at the top of the window that opens. Make sure the Page Size is set to A for this exercise.
3. Select the Grid Reference tab. The settings should match the following picture.
4. Leave all the other tab settings as is except for the Title Block tab. See the following instructions for this.

**Adding a Title Line to the Title Block**

1. Click on the Title Block tab.
2. In the Title field, enter:
   
   Lesson3

**Adding a Name and Address**

1. In the Organization Name field, enter your company name.
2. In the Organization Address1 field, enter your company street address.
3. In the Organization Address2 field, enter city, state, and zip code.
4. Use the Address3 and 4 fields ONLY if necessary.
Adding a Document Number/Revision Number

1. In the Document Number field, enter:
   EMA-12345678
2. In the Revision field, enter:
   A
3. **OPTIONAL** - Add a Cage Code IF you need the information on your design pages.
   US987654
4. Click the browser button to the right of the Library Name field, and navigate to your training directory, D:\EMA_Training\Capture.
5. Click on Training-lib.olb and click Open.
   
   The above path may vary, depending upon your training site and where the Cadence software has been installed.
6. In the Title Block Name field, enter:
   TitleBlock0
7. Compare your settings to the following example, and click OK. (The following is an example only.)
This design template will take effect when you create a new schematic in Lesson 8. The default settings for page size, grid reference, and fonts will also be applied.